CHAPTER

Managing Security

This chapter describes how Cisco ANA implements a two-dimensional security engine combining a
role-based security mechanism with scopes (groups of NEs) that are granted to users. In addition, it
describes managing users in the Cisco ANA platform, including defining users and passwords.

Security Overview—Describes the security-related concepts and terms used in Cisco ANA Manage
and throughout this guide.

Customizing Security Flow—Describes the steps required to customize security.

Creating Scopes—Describes how to group a collection of managed NEs together in Cisco ANA
Manage. In addition, it describes how to edit the NEs included in a scope, how to view the scope’s
properties, and how to delete a scope.

Creating New Cisco ANA User Accounts—Describes how to create permitted users for the current
client station.

Granting or Editing a User’s Rights—Describes how to manage general user account information
and the list of scopes assigned to the user, as well as the security access roles per scope, and assign
maps to a user.

Deleting a Cisco ANA User Account—Describes how to delete a user account from the list of users.

Changing a User Password—Describes how the administrator can redefine the user’s password. In
addition, it describes how the current user can change the user password.

Security Overview

This section describes the security related concepts and terms used in Cisco ANA Manage.

Scopes

Cisco ANA Manage enables the administrator to group a collection of managed NEs together in order
to enable the user to view and manage the NEs based on the user’s role or permission.

After the user is allocated a scope (list of NEs) and a role, they can perform various activities on the NEs
included in the scope, as follows:

Activate services.
Manage alarms in NetworkVision.

Manipulate graphical NEs in the map.
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View NE, inventory, and link properties.
Add NEs to the map view.
Manipulate business tags per NE.

Manage advanced options, for example, show counters, show utilization, and refresh.

By default, Cisco ANA includes a pre-configured scope, All Managed Elements, for the administrator’s
use, which cannot be edited or deleted. This default scope includes all the managed NEs. A user granted
the All Managed Elements scope can view and manage all the NEs all the time according to the user’s
role assigned to the scope.

Default Permissions

The role or default permission only applies to the activities that are related to GUI functionality, not the
activities related to NEs, including:

Application login.
Manage alarms in NetworkVision.
Manage maps—Creating, deleting, and opening.

Map manipulation—Arrange map, including, aggregations, adding NEs, NEs placement in map,
map background and so on.

Business tag management.

Security Access Roles

Cisco ANA provides five pre-defined security access roles that can be granted to a user in order to enable
system functions:

~

Administrator—Manage the system configuration and security. Cisco ANA Manage supports
multiple administrators.

Configurator—Activate services and configure the network.
Operator Plus—Manage the alarm lifecycle.
Operator—Configure business tags and manage most day-to-day operations.

Viewer—View-only access to the network and to non-privileged system functions.

Note  Roles can be granted per scope or at an application level (all the activities that are related to GUI
functionality, not the activities related to devices). Users can have different roles for different scopes.
Role functionality is incremental.
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The table below describes role functions according to the default permission and scope-based

functionality:
Role Default Permission-Based Functionality |Scope-Based Functionality
il Platform management:
o ¢ Manage Cisco ANA servers, AVMs,
Administrator

transport, and VNEs.

¢ Global setting—Managing polling
groups, protection groups, client
licenses, and service disclaimers.

e View DB segments.

¢ Create and delete scopes.

e Manage user accounts.

e Manage static topology links.

e Manage VNEs from Cisco ANA
Manage or NetworkVision.

Map management:

e Open, edit, and delete all user maps.

Configurator

Map management:
e Create maps.
Advanced tools:

¢ Ping and telnet an NE directly from
the client.

e Enable and disable port alarms.

e (Cisco ANA Command Builder.

Activation services:

e Allow activation commands per
managed NE.

fal

OperatorPlus

Map management:
e Create new maps and add NEs.
e Edit, delete, and rename maps.
e Save maps.

Map manipulation:
e Create and break aggregations.
e Change map layout.
e Set background image.

e Create business links.

Alarm management:

e Acknowledge, remove, and clear
alarms that belong to the NEs within
a user’s scope that have the
OperatorPlus role.

Map manipulation:
e Create business tags for NEs.
Display network information:

e Including path tool traffic, rates,
drops or any dynamic data.
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Default Permission-Based Functionality

Scope-Based Functionality

El

Operator

Map manipulation:
¢ Create and delete business tags.
Application:

e Open EventVision.

Display network information:

e Refresh port information from NE.

(G

Viewer

Application:

e Login to NetworkVision and
EventVision.

¢ Change user password.
e View the device list.

e View map.

e View link properties.

e Use table filter.

e Export from any table.

Display network and business tag
information:

e View alarm list, alarm properties,
and find alarms.

e Find and view attachments.
e View NE properties and inventory.
e Calculate and view affected parties.

¢ Open port utilization graph.

Customizing Security Flow

The flow below describes the steps required to customize security using Cisco ANA Manage, and the
order in which the steps must be performed.

Figure 10-1

Customizing Security Flow

Step 1: Install a license

Step 2: Define a scope(s)

Step 3: Define Cisco ANA
user accounts

Step 4: Grant scopes and
roles to a user(s)

180047

Step 1 Install a license. This allows the administrator to control and monitor the number of client and BQL
connections over a limited or unlimited period of time based on the client licenses installed. For more
information, see Managing Client Licenses, page 7-1.
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Step 2

Step 3

Step 4

Creating Scopes

Define a scope. This enables the administrator to group a collection of managed NEs together in order
to enable the user to view and manage the NEs based on the user’s role. For more information, see
Creating Scopes, page 10-5.

Define Cisco ANA user accounts. This enables the administrator to define and manage user accounts.
For more information, see Creating New Cisco ANA User Accounts, page 10-7.

Grant scopes and roles to a user. This enables the administrator to manage general user account
information and the list of scopes assigned to the user as well as the security access roles per scope. For
more information, see Granting or Editing a User’s Rights, page 10-8.

Creating Scopes

Step 1
Step 2

Step 3
Step 4

Cisco ANA Manage enables the administrator to group a collection of managed NEs together in order
to enable the user to view and manage the NEs based on the user’s role or permission.

Once a scope is created it can be assigned to a user. Multiple scopes can be assigned to a single user and
a single scope can be assigned to multiple users. When the scope is assigned to a user, the administrator
is required to provide the user with security access roles as well, namely, to define the user’s role within
the assigned scope. See Granting or Editing a User’s Rights, page 10-8.

To create a scope:

Choose the Scopes branch in the Cisco ANA Manage window.

Right-click to display the menu and choose New Scope, or from File menu, choose New Scope, or on
the toolbar, click New Scope. The New Scope dialog box is displayed.

The following fields are displayed in the New Scope dialog box:
¢ Scope—The name of the scope (unique).
e Available Devices—A list of all the available devices.
¢ Active Devices—A list of all the active devices defined for the scope.

The following buttons are displayed in the New Scope dialog box:

Add All—Adds all available devices to the Active Devices list.

Add Selected—Adds the active device to the Active Devices list.

Remove Selected—Removes an active device from the scope.

Remove All—Removes all active devices from the scope.

) Ll

Enter a name for the scope in the Scope field.

Choose a device from the list of Available Devices, and click Add Selected to add the device to the list
of Active Devices in the scope.
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~

Note Multiple rows can be selected.

Step5  Click OK. The scope is saved and is displayed in the workspace.

Editing a Scope and Viewing a Scope Properties

Cisco ANA Manage enables the administrator to edit the details of a scope and to view the scope’s
properties.

To edit a scope or view scope properties:

Step1  Select the Scopes branch in the tree pane.
Step2  Select the scope that you want to edit or view in the workspace.

Step3  Right-click the required scope to display the shortcut menu, and choose Properties, or from File menu,
choose Properties, or on the toolbar, click Properties. The Properties dialog box is displayed.

For more information about the Properties dialog box, see Creating Scopes, page 10-5.
Step4d  Edit and view the properties as required.

Step5  Click OK. The Properties dialog box is closed.

Deleting Scopes

A device scope (lists of devices or NE groups) can also be deleted.

~

Note = When a scope is deleted, it is deleted from all users who have the assigned scope.

To delete a scope:

Step1  Select the Scopes branch in the tree pane.
Step2  Select the scope that you want to delete in the workspace.

S

Note Multiple rows can be selected.

Step3  Right-click the required scope to display the shortcut menu, and choose Delete. The scope is deleted and
is not displayed in the workspace.
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Creating New Cisco ANA User Accounts

Note

Note

Step 1
Step 2

The Users branch enables the administrator to define and manage user accounts. This includes managing
general user information as well as security access rights and forced login changes, as required. The
administrator can also monitor the user’s last login time.

Creating a new user using the New User dialog box, is only part of the “creating-user” process. Granting
user security rights to operate Cisco ANA applications are defined in the User Properties dialog box. For
more information, see Granting or Editing a User’s Rights, page 10-8.

The new user is created with a set of pre-defined system defaults, as follows:
e No scopes are assigned to the user.
e The number of connections is unlimited.

e The password must be changed every 30 days.

NetworkVision has the following pre-configured password defaults:

The maximum length of the username and full name is 20 characters.

The minimum length of the user password is 8 characters.

The maximum length of the password is 20 characters.

The minimum number of digits that must be included in the user password is 1.
The username cannot contain any special characters like * # ? and so on.

The password cannot contain the username or vice versa.

To define a user account:

Select the Users branch in the Cisco ANA Manage window.

Right-click to display the menu, and choose New User, or from File menu, choose New User, or on the
toolbar, click New User. The New User dialog box is displayed.

~

Note  Click Show Password Rules to display the current password rules.

The following fields are displayed in the New User dialog box:
¢ User Name—The new user’s name used for logging in (mandatory).

~

Note The username is unique and a maximum of 20 characters may be used. Special characters
may not be used.

e Full Name—The full name of the user (optional).

~

Note A maximum of 20 characters may be used, but no special characters may be used.

¢ Description—A free text description of the user (optional).
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Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

e Password—Enter the new password (mandatory).

~

Note A minimum of 8§ characters must be used, including, at least 1 digit. The maximum length
of the user password is 20 characters.

¢ Confirm Password—Enter the new password again to confirm the new password (mandatory).

The Role dropdown list enables the administrator to define the security access role (permission) for the
new user.

~

Note  The permission only applies to activities or actions that are not related to an NE. For more
information on the functionality that a user can perform, see the Security Access Roles section.

When a new user is defined as an Administrator this user can perform all administrative actions,
including opening all maps, working with all scopes and managing the system using Cisco ANA
Manage. All this is performed with the highest privileges. Cisco ANA Manage supports multiple
administrators. Access rights do not need to be defined for an administrative user. For more information,
see the Security Access Roles section.

The Force Password Change at Next Login checkbox is selected by default and forces the user to
change the user password at next login.

The following button is displayed in the New User dialog box:

¢ Create—Adds the new user to the list of Cisco ANA Client users and the new username is displayed
in the workspace.

Enter a unique User Name (mandatory).

Enter a Full Name and Description (optional).

Enter a Password (mandatory).

Enter the password again in the Confirm Password field (mandatory).
Choose a security access role for the new user from the Role dropdown list.

Click Create. The new username and default security access role are displayed in the workspace.

Granting or Editing a User’s Rights

Note

Once the administrator has defined the scopes and the new user accounts, Cisco ANA Manage enables
the administrator to manage or edit general user account information and the list of scopes assigned to
the user, the security access roles per scope, and assign maps to a user.

A user may have different security access roles for different scopes, and maps.

In addition, the administrator can view the properties of a user.
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User's Rights

Step 1
Step 2
Step 3

Step 4

Granting or Editing a User's Rights

Cisco ANA Manage enables the administrator to manage or edit general user account information. In
addition, the administrator can view the properties of a user.

To grant or edit a user’s rights:

Select the Users branch in the tree pane.
Right-click the required user to display the shortcut menu.

From the shortcut menu, choose Properties. The Properties dialog box is displayed with the General tab
selected by default.

The General tab contains general user account information, and the following fields are displayed:
e User Name—The current user’s name. The username cannot be modified.
e Last Login—The date and time that the user last logged in.
e Full Name—The full username.
e Description—A description of the user.
The following checkboxes are displayed in the General tab of the Properties dialog box:

¢ Enable Account—Choose this option to enable the user account, or uncheck to disable the user
account. The user account is automatically locked when the number of logins defined is exceeded
(the Limit Connections to option is selected). An administrator can manually lock or unlock a user’s
account at any time. A user whose account is locked cannot log into the system.

¢ Limit Connections to—The number of instances of the Cisco ANA client applications that the user
can access at any one time. For example, if the number of connections is limited to 10, the user can
have 5 instances of Cisco ANA Manage and 5 instances of NetworkVision open at the same time. If
the user then tries to open an instance of EventVision, the attempt is refused.

¢ Force Password Change After—The number of days after which a user is forced to change their
password.

¢ Force Password Change at Next Login—Choose this option to force the user to change the user
password at next login. The administrator can define this option at any time.

Edit the general properties as required.

User Security Rights

Step 1
Step 2

Step 3

To define a user’s default security rights, you use the Security tab in the User Properties dialog box.

To edit a user’s default security rights:

Select the Users branch in the tree pane.

Right-click the required user to display the shortcut menu, and choose Properties. The User Properties
dialog box is displayed.

Choose the Security tab.
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Step 4

Step 5
Step 6
Step 7

Step 8

The Security tab controls the user’s capability to view and manage the application and NEs by granting
the user scopes and security access roles. By default, a new user is assigned a viewer security access role.
The following columns are displayed in the table in the Security tab of the Properties dialog box—

¢ Scope Name—The name of the scope.

e Security Level—The security access role defined for the scope. For more information, see Security
Access Roles, page 10-2.

The following buttons are displayed in the Properties dialog box when the Security tab is selected:
¢ Add—Adds the new scope.
¢ Remove—Deletes the selected scope from the user’s active rights.
e Edit—Edits the selected permission of the user.
Click Add to add the scope to the Active Rights of the user. The Security Level dialog box is displayed.
The following area is displayed in the Security Level dialog box:
e Available Scopes—Lists all the predefined and unassigned scopes.
The following list is displayed in the Security Level dialog box:

¢ Security Level—Displays the security access roles for the defined scopes. For more information,
see Security Access Roles, page 10-2.

Choose a scope from the Available Scopes list.
Choose the required security access role from the Security Level list.

Click OK. The scope is added to the list of Active Rights in the Security tab of the User Properties dialog
box.

Click Apply/OK. The Properties dialog box is closed.

Map User Permissions

Step 1
Step 2

Step 3

Cisco ANA Manage enables the administrator to assign a maps to the user. When the user logs into
NetworkVision, the user can only open and manage the maps assigned to the user by the administrator.

To assign maps to a user:

Select the Users branch in the tree pane.

Right-click the required user to display the shortcut menu, and choose Properties. The User Properties
dialog box is displayed.

Choose the Maps tab.
The Maps tab is divided into two parts:

e The left side displays a list of all the available maps in the database that have not been assigned to
the user.

e The right side displays all the maps that have been assigned to the user, and which the user can open
and manage in NetworkVision.
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Step 4

Step 5
Step 6

Deleting a Cisco ANA User Account Il

The following buttons are displayed between the available maps and assigned maps lists in the Maps tab:

Moves the selected map to the Assigned Maps list.

Move the entire available map list to the Assigned Maps list.

Removes a selected map from the assigned map list to the Available Map
list.

Removes the entire assigned map list to the Available Map list.

JElElE

Choose a map from the list of Available Maps, and click on the required button (as described above) to
add the map to the list of Assigned Maps to the user.

~

Note = Multiple rows can be selected.

Choose and move maps between the two lists, as required, using the appropriate buttons.

Click OK to confirm the user’s assigned map(s).

Deleting a Cisco ANA User Account

Step 1
Step 2

Step 3

An administrator can also delete a Cisco ANA user account.

To delete a user account:

Select the Users branch in the tree pane.

Select the user that you want to delete in the workspace.

~

Note = Multiple rows can be selected.

Right-click the required user to display the shortcut menu and choose Delete. The selected user is
deleted, and is not displayed in the workspace.
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Changing a User Password

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

Step 1

Step 2
Step 3
Step 4
Step 5

The administrator can use Cisco ANA Manage to change the user’s password at any time. When this
happens the user is usually forced to change the password at the next login.

In addition, the current user can also initiate a change of password, where they will be required to enter
the old password in order to validate the new password.

To change a user’s password as an administrator:

Select the Users branch in the tree pane.
Select the user in the workspace whose password you want to change.

Right-click the required user to display the shortcut menu, and choose Change Password. The Change
Password dialog box is displayed.

~

Note  Click Set Password Rules to display the password rules.

Enter the new password in the Password and Confirm Password fields.
Click OK. A confirmation message is displayed.
Click OK. The Change Password dialog box is closed.

Cisco ANA Manage enables the current user to also initiate a change of password.

To change the user’s own password:

From the Tools menu, choose Change User Password. The Change User Password dialog box is
displayed.

a~

Note  Click Set Password Rules to display the password rules.

Enter the old password in the Old Password field.

Enter the new password in the New Password and Confirm Password fields.
Click OK. A confirmation message is displayed.

Click OK. The Change User Password dialog box is closed.
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